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	Number System

Let’s Plug-in  (Page no. 7)

Do it yourself.

Let’s Catch Up  (Page no. 11)

(91)10 = (1011011)2

2	 91
2	 45            1
2	 22            1
2	 11            0
2	   5            1
2	   2            1
	   1            0

Let’s Catch Up  (Page no. 12)

	 1	 0	 0	 0		  .	 1	 0
	 23	 22	 21	 20		  .	 2–1	 2–2

	 1 × 23 + 0 + 0 + 0	 .	 2–1 + 0
			   =		  8	 .	 (½) = 0.5
			   =		  8.5

Let’s Catch Up  (Page no. 13)
	 10001
	 – 1001
	 =  1000

Test Your Skills

1.	 a. (ii)	 b. (i)	 c. (ii)	 d. (i)	 e. (ii)

1.
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2.	 a. T	 b. F	 c. T	 d. T	 e. T
3.	 a. 0	 b. 2	 c. decimal number
	 d. 10	 e. 8	 f.  binary
4.	 �a.	The octal number system is used as a shorthand representation of long binary numbers.
	 b.	4 bits make 1 nibble.
	 c.	Base of a number system represents the total number of digits in a number system. 
5.	 a.	A Number System is simply a method of counting. There are many number systems in existence. 

The digital computer represents all kinds of data and information like audio, graphics, video, 
text and numbers in binary form. The total number of digits used in a number system is called 
its base or radix.

	 b.	To convert a decimal number into a binary number, follow these steps:
		  Step 1: Divide the decimal number by 2 (the base of the binary number system).
		  Step 2: Note down the quotient and the remainder.
		  Step 3: Divide the quotient obtained again by 2 and note down the resulting quotient and 

remainder.
		  Step 4: Repeat the procedure till you reach a quotient less than 2.
		  Step 5: List the last quotient and all the remainders (moving from bottom to top). You will 

get your binary number.
	 c.	 X Y X – Y

0 0 0 – 0 = 0

0 1
0 – 1 = 1

(borrow 1, so that 
10 – 1 = 1)

1 0 1 – 0 = 1
1 1 1 – 1 = 0

Fun Zone

Let's Solve
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Let’s Explore

Do it yourself.

Tech Practice

1.	 23.375
2.	 011001
3.	 a.  01101	 b.  10000	 c.  01110	 d.  011110	 e.  0101110
4.	 a.  10011	 b.  1100010	 c.  1001011 	 d.  100101	 e.  110110

	Charts in Excel 2016

Let’s Plug-in  (Page no. 17)
1.	 Deepak		  2.  Anurag

Let’s Catch Up  (Page no. 19)
1.	 Scatter chart	 2.  Area chart 	 3.  Bar chart 	 4.  Pie chart 

Test Your Skills

1.	 a.  (ii)	 b.  (ii)	 c.  (ii)	 d.  (ii)	 e.  (iii)
2.	 a.  F	 b.  F	 c.  T	 d.  T	 e.  F
3.	 a.  Chart	 b.  Gridlines	 c.  Legend 	 d.  Column	 e.  Pie 

4.	 a.  (ii)	 b.  (iii)	 c.  (iv)	 d.  (i)

5.	 a.	 A chart is an effective way to display data in a pictorial form. It makes it easier to draw 
comparison and analyse the growth, relationship and trends among the values in a table.

	 b.	Legend is a key which shows the meanings of symbols and colours used in the chart.
	 c.	 Bar chart displays the data in the form of long rectangular rods, also called bars.
	 d.	Area chart is used to display the quantitative magnitude of the data graphically.
6.	 a.	 Line Chart: It is used to show trends over a period of time. It is similar to plotting a graph 

on a graph paper with its values on X and Y axis. It uses connecting dots to display trends 
of a data over a given period of time. Whereas Scatter charts are also known as XY scatter 
plot charts. They show the correlation between the two sets of values. The x and y axes are 
used to represent the data plots on the chart.

2.
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	 b.	The five components of charts are as follows:
		  Data Series: It is related to the set of values. It is represented by the bars or slices that 

represent the data values.
		  Data Labels: It includes data values, category name, series name, legend keys and values 

from cells.
		  Gridlines: These can be either horizontal or vertical lines depending on the selected chart 

type. It makes it easier to read and understand the values.
		  Legend: It is a key which shows the meanings of symbols and colours used in the chart.
		  Chart Area: It includes all the objects and elements of a chart.
	 c.	 Follow these steps to change the chart type:
		  Step 1: Select the chart.
		  Step 2: Click on the Change Chart Type command from Type group under the Design tab.
		  Step 3: Click on Line from the left panel of the Change Chart Type dialog box.
		  Step 4: Click on Line with Markers option from the right panel under Line group.
		  The chart will change to Line Chart.

Fun Zone

Let's Solve

1.	 Pie chart

2.	

5

2

1
3

4
7

6

T

G
A

L S

L

T E

R

CS

G

A

O

H

N

B

P

R

D

T

D

A

A

R

EI

R

E

T

I N

Let’s Explore

Do it yourself.

Tech Practice

Do it yourself.
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Periodic Assessment–1
(Based on chapters 1 & 2)

A.	 1.	The rightmost digit before the fractional part of a binary number is known as LSD.
	 2.	Hexadecimal number system consists of 16 digits, 0 to 9 and A to F.
	 3.	 In BEDMAS rule, E stands for exponents.
	 4.	Legend is a key which shows the meanings of symbols and colours used in the chart.
	 5.	Conditional Formatting command is present under Home tab.
B.	 1.	 It is commonly used to display the data in the form of vertical bars. It is used to show the 

changes in data over a period of time or comparison among different data items. This chart 
can be used to depict and compare the results of your friends.

	 2.	 It is a circular chart divided into sectors where each sector shows the relative size of each 
value. It always shows only one data series. You can use pie chart to explain the distribution 
of the various gasses in the atmosphere.

	 3.	 It is used to display the quantitative magnitude of the data graphically. You can use this chart 
to show the level of depletion of ozone layer in the atmosphere.

	 4.	Bar chart displays the data in the form of long rectangular rods also called bars. This chart 
can be used to differentiate the individual element of any comparison. You can use this chart 
to show Cost Price and Selling Price of different items.

	 5.	They show the correlations between the two sets of values. This chart can be used to show 
the relation between the degradation of soil quality due to the increase in population.

C.	 1.    Decimal	 Octal 	 Scientific	 Binary

	 2.    A 	 C	 F	 H

	 3.  Bar 	 Pie 	 Data 	 Column 

	 4.  Int 	 Bit 	 Nibble 	 Byte

D.	  1. c.	 2.  e.	 3.  b.	 4.  a.	 5.  d.

	Advanced Features of Excel

Let’s Plug-in  (Page no. 26)
1.	 F	 2.  T	 3.  T	 4.  F	

Let’s Catch Up  (Page no. 28)
Sorting refers to the process of arranging data in ascending or descending manner. It helps us to 
obtain data quickly and work efficiently. 

3.
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Test Your Skills

1.	 a. (i)	 b.  (ii)	 c.  (ii)	 d.  (ii)	 e.  (ii)
2.	 a.  F	 b.  F	 c.  F	 d.  T	 e. T
3.	 a.	 Sorting data means to organise the data in ascending or descending order.
	 b.	 To remove filters, click on the filter command in the Data tab. 
	 c.	 Filter command is used to hide unimportant data.
4.	 a.	 Sorting data refers to the process of organizing data in ascending or descending order. 

Whereas, filtering data refers to remove or hide the unimportant data to emphasise on the 
important information. 

	 b.	 Conditional formatting can be applied on the following criteria:
		  i.  Highlight Cells Rules	 ii.  Top/Bottom Rules           iii.  Data bars
	 	 iv.  Color Scales 	 v.  Icon sets
	 c.	 To use Custom Sorting, follow these steps:
		  Step 1: Select the range of columns to be sorted.
		  Step 2: Click on the Sort & Filter command from the Editing group under Home tab. A 

dropdown list appears.
		  Step 3: Click on the Custom Sort option from the drop-down list.
		  The Sort dialog box opens.
		  Step 4: Check My data has headers checkbox, if the selected columns have a heading at the 

top.
		  Step 5: Click on the Sort by box and select the column header according to which you want 

to sort the data. In this case, we have selected Client Name header.
		  Step 6: Click on the Sort On box and select Cell Values option.
		  Step 7: Click on the Order box and select the A to Z or Z to A option. In This case, we have 

selected A to Z option.
		  Step 8: Click on the Add Level button at the top of the Sort dialog box to add another column 

to sort. In this case, we have added Amount Billed column.
		  Step 9: Click on the OK button.
	 d.	 To apply conditional formatting to a series of data, follow these steps:
		  Step 1: Select the data to which formatting is to be applied.
		  Step 2: Click on the Conditional Formatting command from Styles group under Home tab. 

A drop-down list appears. This list shows various criteria.
		  Step 3: Select the desired conditional formatting. In this case, we have selected the Orange 

Data Bar option under the Data Bars category. The selected conditional formatting is applied 
to the selected cell range.
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Fun Zone

Let's Solve

1.	 Sorting 
2.	 a.  Editing	 b.  Filter 	 c.  Sorting 	 d.  Conditional Formatting
	 e.  Sort A to Z (text). Sort Smallest to Largest (numbers).

Let’s Explore

Do it yourself.

	More On Animate CC

Let’s Plug-in  (Page no. 34)
1.	 T		  2.  F		  3.  T		  4.  T

Let’s Catch Up  (Page no. 37)
1.	 Three	 2.  Frame 1 of Layer 1	 3.  Frames per second
4.	 Movie Clip Symbol

Test Your Skills

1.	 a.  (ii)	 b.  (iii)	 c.  (iii)	 d.  (iii)	 e.  (ii)
2.	 a.  Masking	 b.  Layers	 c.  Properties	 d.  Break Apart
3.	 a.  T	 b.  T	 c.  F	 d.  F	 e.  T
4.	 a.	 The movement of an object in-between the frames is called Tween.
	 b.	i.  Motion Tween     ii.  Shape Tween     iii.  Classic Tween
	 c.	 Classic Tween is used for transition purpose, Whereas Motion Tween uses symbols to create 

movement, size, rotation changes, fades, etc.
5.	 a.	 Layers are sheets on which you place your drawings, animations and objects. They allow you 

to keep the elements of the animation separate. These are similar to transparent sheets, 
stacked one on top of the other.

	 b.	Perform the following steps to format text in Animate:
			  Step 1: Click on the Text Tool from the Tools panel. 

4.
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			  Step 2: Under the Properties panel choose the font size, color, style, etc.
			  Step 3: Type the text “ANIMATE” on the stage.
			  We can individually split the text with the Break Apart option. 
			  Step 4: Select the text with Selection Tool. 
			  Step 5: Click on the Modify ➔ Break Apart option from the menu bar.
			  Step 6: Select the individual character and change the color.

Fun Zone

Let's Solve

1.	 a.	 Break Apart	 b.  Shape Tween
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Let’s Explore

Do it yourself.

Tech Practice

Do it yourself.

Periodic Assessment–2
(Based on chapters 3 & 4)

A.	 1.	Sorting data means to organise the data in ascending or descending order.
	 2.	Filtering is used to separate unwanted material from a mixture. Excel also allows you to filter 

unwanted data from a set of data.
	 3.	The movement of an object in-between the frames is called Tween.
	 4.	Layers are sheets on which you place your drawings, animation and objects.
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B.	

Layer

Insert Layer Delete Layer

C.	 Ritika can use Sort & Filter command.

Test Sheet–1
(Based on chapters 1 to 4)

A.	 1.  (ii)	 2.  (i)	 3.  (i)	 4.  (ii)	 5.  (ii)
	 6.  (ii)	 7.  (iii)	 8.  (ii)
B.	 1.  T	 2.  T	 3.  F	 4.  F	 5.  T
	 6.  T	 7.  F
C.	 1.  0	 2.  2	 3.  Filter	 4.  Pie	 5.  Properties
	 6.  Break Apart
D.	 1.	Sorting data means to organise the data in ascending or descending order.
	 2.	To remove filters, click on the filter command in the Data tab.
	 3.	The octal number system is used as a shorthand representation of long binary numbers.
	 4.	Masking in Animate is used to hide a selected part and display content instead on a layer. 

Masking enables us to control the content that is visible to the audience.
E.	 1.	To apply conditional formatting to a series of data, follow these steps:
		  Step 1: Select the data to which formatting is to be applied.
		  Step 2: Click on the Conditional Formatting command from Styles group under Home tab. 

A drop-down list appears. This list shows various criteria.
		  Step 3: Select the desired conditional formatting. In this case, we have selected the Orange 

Data Bar option under the Data Bars category. The selected conditional formatting is applied 
to the selected cell range.

	 2.	Conditional formatting can be applied on the following criteria:
	 	 i.  Highlight Cells Rules	 ii.  Top/Bottom Rules           iii.  Data bars
	 	 iv.  Color Scales 			   v.  Icon sets
	 3.		 In binary subtraction, binary number of lower value is subtracted from the binary number 

of higher value. The following table explains the subtraction of digit Y from digit X. If Y is 
greater than X, then 1 is borrowed from the next position. When the binary digit 0 borrows 
1 from the next most significant digit, it becomes 10.
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	 4.	Classic tween is primarily used for transition whereas Motion Tween makes an object move 
along a guided path.

	 5.	Gridlines can be either horizontal or vertical lines depending on the selected chart type. It 
makes it easier to read and understand the values.

	 6.	Follow these steps to change the chart type:
		  Step 1: Select the chart.
		  Step 2: Click on the Change Chart Type command from Type group under the Design tab.
		  Step 3: Click on Line from the left panel of the Change Chart Type dialog box.
		  Step 4: Click on Line with Markers option from the right panel under Line group.
		  The chart will change to Line Chart.

	 Internet Services

Let’s Plug-in  (Page no. 51)

	     		    		      			    
	 Facebook		  Twitter		  Instagram		  YouTube

Test Your Skills

1.	 a.  (i)	 b.  (i)	 c.  (iv)	 d.  (iv)	 e.  (ii)
2.	 a.  T	 b.  F	 c.  F	 d.  T	 e.  T
	 f.  F	 g.  F
3.	 a.  cash on delivery		  b.  communicate, information
	 c.  facebook	 d.  blogger	 e.  questions	 f.  cloud storage
4.	 a.	 Facebook, Twitter and Instagram.
	 b.	 Net Banking and E-Wallet.
	 c.	 You are not allowed to post political content and poorly phrased questions.
	 d.	 This feature on Facebook allows the user to find all his active Facebook logins from any 

device. 
	 e.	 (i) Your sensitive data might be at risk from hackers.
		  (ii) Some people might face issues like data loss.
5.	 a.	 Blog is a short form of WEBLOG, which refers to a website where new information about any 

topic is updated regularly. The latest posts appear first. The term Weblog was coined by an 
American blogger named Jorn Barger in 1997. It is like a journal where you write about your 
life and thoughts types are travel blog, fashion blog etc.

5.
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	 b.	 The key features of Skype are as follows:
		  •  Skype translates the conversation in real-time if the person is talking in a different language.
		  •  It is a safe way to have conversation with people without any interruption.
		  •  You can share your screen to train someone.
		  •  It has Live Subtitles option. This helps a hearing-impaired person to keep up with the call. 
	 c.	 1.  It fetches the updated web feed. 
		  2.  It provide newly published information from the website/blog directly to you.
		  3.  It saves your time.
	 d.	 Website is a collection of static pages such as home page, contact page, profile page. On the 

other hand, blog contains both pages and posts but mostly posts. Websites usually don’t 
change regularly as blogs do.

Fun Zone

Let's Solve

1.	 a.	 Cloud Computing	 b.  Facebook
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Let’s Explore

Do it yourself.

Tech Practice

Do it yourself.
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	App Development

Let’s Plug-in  (Page no. 68)
Do it yourself.

Let’s Catch Up  (Page no. 69)
The application that is mainly developed for computer or laptop is called a desktop application 
whereas A Web app is an application program that is stored on a remote server and accessed over 
the Internet through a Web browser interface. 

Let’s Catch Up  (Page no. 70)

Let’s Catch Up  (Page no. 79)
Design view contains all the components required to design an application. 

Test Your Skills

1.	 a.  (i)	 b.  (i)	 c.  (i)	 d.  (i)	 e.  (iii)
2.	 a.  F	 b.  T	 c.  F	 d.  T	 e.  T
3.	 a.  hybrid	 b.  Mobile	 c.  Android	 d.  gaming	 e.  install
4.	 a.	 An app is a software program primarily developed for hand-held smart devices such as 

mobile and tablet.
	 b.	 Web apps are actually web applications which give a user experience similar to native apps.
	 c.	 Native apps are the type of Mobile apps. These are platform dependent which means that 

these apps are primarily developed for a specific platform.
	 d.	 E-commerce apps allow us to buy or sell products while sitting at home or any other place.
5.	 a.	 (i)	 Gaming Apps- Today’s most popular category of mobile apps is gaming apps which 

share more than 24% area of the app store. The most commonly used gaming apps 
are PUBG, Candy Crush Saga, and Angry Birds.

		  (ii)	 Productivity apps, also known as business apps used by businessmen to perform several 

6.
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complex tasks. The most commonly used productive apps are Google Calendar, Evernote 
and Dropbox.

		  (iii)	 Entertainment apps are developed to entertain the people. The most commonly used 
entertainment apps are Netflix, Talking Tom and YouTube.

	 b.	 To change the display name, follow the given steps: 
		  Step 1: Click on the button in the View pane. 
		  Step 2: Type a new name for button in the Text box. 
	 c.	 The difference between web app and website is that a web app can be a small part of a 

website which provides a particular functionality. On the other hand, a website can contain 
many web apps.

	 d.	 Educational apps provide a platform for children to learn from anywhere and anytime. These 
apps use advance methodologies and new concepts to make the learning easier. The most 
commonly used educational apps are Khan Academy, Vedantu, and Grammar EN.

Fun Zone

Let's Solve

1.	 a.	 Gaming		 b.  Music Player
2.	 a.	 Mobile apps	 b.  Google Playstore	 c.  iOS			   d.  Web application
	 e.  App Store	 f.  Hybrid app		  g.  Gaming app		  h.  Educational app
	 i.  Social networking apps			   j.  Web apps

Let’s Explore

Do it yourself.

Tech Practice

Do it yourself.

	More on HTML5

Let’s Plug-in  (Page no. 83)
1.	 what you see is what you get	 2.  hyperlink	 3.  HTML5

Let’s Catch Up  (Page no. 88)
text-align

7.
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Test Your Skills

1.	 a.  (i)	 b.  (i)	 c.  (ii)	 d.  (i)
2.	 a.  markup	 b.  margin	 c.  <P>	 d.  <SUB>	 e.  <SUP>
3.	 a.  F	 b.  F	 c.  F	 d.  F	 e.  F
4.	 a.	 HR tag is used when you want to divide your web page into different sections.
	 b.	 text-indent property is used for indentation in HTML5.
	 c.	 The <SUP> tag is frequently used to write algebraic formulas.
5.	 a.	 HR tag is used when you want to divide your web page into different sections.
		  The <HR> tag has following attributes:
		  •	 WIDTH:  It displays the horizontal ruler of the specified width in pixels or in percentage.
		  	 <hr width=”550”>  or  <hr width=”80%”>
		  •	 SIZE: It controls the height or the thickness of the horizontal ruler.
		  	 <hr size=”4”>
		  •	 COLOR: It is used to apply the background color.
		  	 <hr color=”pink”>
		  •	 ALIGN: It is used to align the horizontal ruler left, right and center.
		  	 <hr align=”right”>
	 b.	 HTML provides the <FONT> tag to change the certain properties such as font size, face and 

colour of a block of text on a web page. <FONT> tag provides three attributes which you 
can use in the following way: 

		  1.	 FACE: It allows you to set the font family such as Times New Roman, Verdana.
				   <font face=”Times New Roman”> Animation </p>
		  2.	 SIZE: It allows you to set the font size. 
				   <font size=”4”> Animation </p>
		  3.	 COLOR: It allows you to set the font color. 
				   <font color=”green”> Animation </p>
	 c.	 (i)	� <SUB> tag is used to turn the enclosed text into a subscript. For example, H2O is coded 

as H<sub>2</sub>O
				�   <SUP> tag is used to turn the enclosed text into a superscript. For example, E=mc2 is 

coded as E=mc<sup>2</sup>
		  (ii)	�text-align Specifies the alignment of the text whereas text-indent Specifies the indentation 

of the first line of the text.

Fun Zone

Let's Solve

1.	 <html>  <title> <body bgcolor=”green”> <h1 align=center> <hr> <p>< font face><sup>
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Let’s Explore

Do it yourself.

Tech Practice

Do it yourself.

	Lists and Tables in HTML5

Let’s Plug-in  (Page no. 96)
Do it yourself.

Let’s Catch Up  (Page no. 101)
An ordered list is used to display the items in sequential manner. Whereas, an unordered list is used 
to display random items which never require to place in a sequential manner. 

Let’s Catch Up  (Page no. 107)
	 1.  Border	 2.  Frames	 3.  Background	 4.  BGCOLOR 

Test Your Skills

1.	 a.  (iii)	 b.  (i)	 c.  (iii)	 d.  (i)	 e.  (iv)
2.	 a.  F	 b.  F	 c.  F	 d.  F	 e.  T
3.	 a. ordered list	 b. list item	 c. <UL>	 d. disc
	 e. <CAPTION>
4.	 a.	 A list is a collection of related items.
	 b.	 Table represents data in the form of rows and columns.
	 c.	 The description list is a type of list in which terms with their definitions are displayed.

5.	 a.	� The main difference between ordered list and unordered list is that the ordered list displays 
the items in a sequential manner and unordered list displays items in an non-sequential 
manner.

	 b.	 The attributes of the <TABLE> tag are BORDER, BORDERCOLOR, FRAMES, BGCOLOR, 
BACKGROUND, HEIGHT, WIDTH, CELLSPACING and CELLPADDING.

	 c.	 The ROWSPAN attribute applies when a single cell is extended for more than a single row 

8.
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and the COLSPAN attribute applies when a single cell is extended to more than a single 
column.

Fun Zone

Let's Solve
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2.	 a.	 <OL> tag	 b.  <TABLE> tag	 c.  COLSPAN

Let’s Explore

Do it yourself.

Tech Practice

Do it yourself.

Periodic Assessment–3
(Based on chapters 5 to 8)

A.	 <body bgcolor=”red”>
	 <p> and not </p>
	 Need to close the <p> at the end of the paragraph
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B.	� (This question was printed incorrectly in the book, please correct this question in your textbook) 
	 Give an example of the following: 
	 1. Utility Apps _________________________________________________ 
	 2. E-wallet _________________________________________________ 
	 3. Net-Banking _________________________________________________ 
	 4. Social Networking Apps _________________________________________________ 
	 5. Web Apps _________________________________________________ 
	 Ans: 1. SHAREit	 2. Google Pay	 3. ATM	 4. LinkedIn	 5. OLX 
C.	 �(This question was printed incorrectly in the book, please correct this question in your textbook) 
	 Write the uses of the followings. 
	 1. ROWSPAN ______________________________________________________ 
	 2. font-family ______________________________________________________ 
	 3. background-image ______________________________________________________ 
	 4. border ______________________________________________________ 
	 5. border-spacing ______________________________________________________ 
	 Ans: 1. �The ROWSPAN attribute applies when a single cell is extended for more than a single 

row, that is, the cell spans for 2 or more rows instead of 1 as shown in below table. 
	 2. font-family to change the font face.
	 3. Specifies the image to be used in the background on the web page. 
	 4. The border property of CSS allows you to apply a border to an element of HTML like. 
	 5. �The border-spacing property is used to specify the space between the borders of adjacent 

cells. 

	Conditional Statements in Python

Let’s Plug-in  (Page no. 112)
	 1.  True	 2.  84	 3.  8 2 20 	 4.  True	 5.  22

Let’s Catch Up  (Page no. 116)
age = 17
if(age > 18):
    print(‘You are eligible to vote’)
else:
    print(‘Not eligible to vote’)

9.
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Test Your Skills

1.	 a.  (iii)	 b.  (i)	 c.  (iv)	 d.  (ii)	 e.  (iii)	
2.	 a.  if	 b.  true	 c.  false	 d.  else
3.	 a.  F	 b.  F	 c.  F	 d.  T	 e.  T
4.	 a.	 Decision making in Python is done by called conditional statements which decide the flow 

of program execution.
	 b.	 if (Test Expressions_1): 
		      Indented block 1 
		  elif (Test Expression_2): 
		      Indented block 2 
		  elif (Test Expression_3): 
		      Indented block 3 
		  else: 
		      Indented block 
	 c.	 if (Test Expression):
		      Indented statement block   
		  # if block ends here
5.	 a.	

Statement 3

Statement 2

Statement 1

True

True

False

False

Test Expression 1

Test Expression 2

	 b.	 um = float(input(“Enter the distance measured in centimeter : “))
		  “”” 1 inch = 2.54 centimeters”””
		  inc = num/2.54 
			   print(“Distance in inch : “, inc)
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Fun Zone

Let's Solve

	 1.	 First number is greater than second number.
	 2.	 Positive number.
	 3.	 Above ten and also about 20!
	 4.	 b is not greater than a.

Let’s Explore

Do it yourself.

Tech Practice

1.	 year = int(input(“Please Enter the Year Number you wish: “))
		  if (( year%400 == 0)or (( year%4 == 0 ) and ( year%100 != 0))):
	     print(“%d is a Leap Year” %year)
	 else:
	     print(“%d is Not the Leap Year” %year)
2.	 Do yourself
3.	 ch = input(“Enter a character: “)
	 if(ch==’A’ or ch==’a’ or ch==’E’ or ch ==’e’ or ch==’I’
	  or ch==’i’ or ch==’O’ or ch==’o’ or ch==’U’ or ch==’u’):
	     print(ch, “is a Vowel”)
	 else:
	     print(ch, “is a Consonant”)
4.	 num = float(input(“Enter a number: “))
	 if num >= 0:
	    if num == 0:
	        print(“Zero”)
	    else:
	        print(“Positive number”)
	 else:
	    print(“Negative number”)
5. Do it yourself.
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	AI for SDGs

Let’s Plug-in  (Page no. 123)
Do it yourself.

Let’s Catch Up  (Page no. 127)
	 1.  T	 2.  T	 3.  T

Test Your Skills

1.	 a.  (ii)	 b.  (i)	 c.  (ii)	 d.  (iii)	 e.  (i)
	 f.  (ii)
2.	 a.  SDG 	 b. 70%	 c. 17.2	 d. marine pollution
3.	 a.  T	 b.  T	 c.  F	 d.  T
4.	 a. �AI can help in improving the farming land, agriculture, quality of products, etc. AI can also 

help with aid distribution in poor and war-torn areas, or where natural disasters have caused 
heavy destruction.

	 b. �AI can help in achieving this goal by increasing the ability of healthcare professionals to analyse 
huge data sets, providing better feedback and finding accurately the cause of diseases to 
discover the cure.

	 c. This SDG aims to guarantee justice and freedom for all people by 2030.
5.	 a. �It aims to ensure equal opportunities and end discrimination by eliminating discriminatory 

laws, policies and practices. AI may help in improving industrial growth thereby improving 
the global financial market and institutions.

	 b. �AI for climate action has the potential to reduce global greenhouse gas emissions by up to 4 
percent. Using AI and data from NASA, researchers are able to identify patterns and monitor 
changes of land surfaces such as decreasing sea area, ice cap surfaces, etc.

	 c. �AI in education can be used to achieve Quality Education goals by developing smart content, 
providing personalized guidance, round the clock assistance, virtual learning environment 
and creating more secured online exams.

Let's Solve

Do it yourself.

Let’s Explore

Do it yourself.

10.
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Periodic Assessment–4
(Based on chapters 9 & 10)

A.	 Congratulations!!!
	 You have passed the exam
B.	 (This question was printed incorrectly in the book, please correct this question in your textbook)
	 Question: Look at the given SDG’s icons and write their aims.

	 1. 
2 ZERO

HUNGER
 	 _______________________________________________________

	 2. 5
GENDER
EQUALITY 	 _______________________________________________________

	 3. 
8 DECENT WORK AND

ECONOMIC GROWTH

	 _______________________________________________________

	 4. 
10 REDUCED

INEQUALITIES
	 _______________________________________________________

	 5. 
15 LIFE

ON LAND
	 _______________________________________________________

Ans: 	1. SDG 2 aims to end hunger issues by 2030 and ensure access to nutritious food for all children. 
	 2. SDG 5 aims to achieve gender equality and empower all women and girls.
	 3. SDG and aims to lesson the youth unemployment.
	 4. �SDG 10 aims to ensure equal opportunities and end discrimination by eliminating discriminatory 

laws, policies and practices. 
	 5. �SDG 15 aims at protecting, restoring and promoting the sustainable use of terrestrial 

ecosystems, managing forests, fighting deforestation, reversing land degradation and stopping 
biodiversity loss.

C.	 if (Test Expressions_1): 
	 Indented block 1 
	 elif (Test Expression_2):
	 Indented block 2 
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	 elif (Test Expression_3):
	  Indented block 3
	 else: 
	 Indented block

Test Sheet–2
(Based on chapters 5 to 10)

A.	 1.  (iii)	 2.  (iii)	 3.  (ii)	 4.  (i)
	 5. � (This question was printed incorrectly in the book, please correct this question in your 

textbook)
	 Question: By which year does the SDG 2 aims to end hunger? 
	 (i) 2025	 (ii) 2030 	 (iii) 2035	 (iv) 3030 
	 Ans: (ii)
	 6. � (This question was printed incorrectly in the book, please correct this question in your 

textbook)
	 Question: �AI for climate action has the potential to reduce global greenhouse gas emissions 

by up to ______________. 
	 (i) 2%	 (ii) 4% 	 (iii) 8%	 (iv) 16% 
	 Ans: (ii)
	 7. � (This question was printed incorrectly in the book, please correct this question in your 

textbook)
	 Question: �Which of the following SDG aims to guarantee justice and freedom for all people 

by 2030? 
	 (i) SDG 16	 (ii) SDG 17	 (iii) SDG 15	 (iv) SDG 5 
	 Ans: (i)
	 8.  (iv)	 9.  (ii)
B.	 1.  if	 2.  true	 3.   	 4.  list item	 5.  <UL>
	 6.  markup
C.	 1.  T	 2.  T	 3.  F	 4.  F	 5.  F
	 6.  T
D.	 1.	 We can use a variable directly by assigning a value to the variable.
		  For example, name = “Deepak”
	 2.	 Decision making in Python is done by conditional statements which decide the flow of 

program execution. In Python, three types of decision making statements which are if, 
if...else and if...elif...else statements.

	 3.	 Empty tags does not contain any content and closing tag. Whereas, the container tags 
hold some content and also have closing tag. 

E.	 1.	 Control statements are used to control the execution of program. Types of control 
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statements are:
		  1. Break statement	 2. Continue statement
	 2.	 HR tag is used when you want to divide your web page into different sections.
		  The <HR> tag has following attributes:
		  •	 WIDTH: It displays the horizontal ruler of the specified width in pixels or in percentage.
			 	    <hr width=”550”> or <hr width=”80%”>
		  •	 SIZE: It controls the height or the thickness of the horizontal ruler.
				   <hr size=”4”>
		  •	 COLOR: It is used to apply the background color.
				   <hr color=”pink”>
		  •	 ALIGN: It is used to align the horizontal ruler left, right and center.
				   <hr align=”right”>
	 3.	 Website is a collection of static pages such as home page, contact page, profile page. On 

the other hand, blog contains both pages and posts but mostly posts. Websites usually 
don’t change regularly as blogs do.

	 4.	 (This question was printed incorrectly in the book, please correct this question in your 
textbook)

	 Question: Write the goal of SDG 16. 
	 Ans: This SDG aims to guarantee justice and freedom for all people by 2030. 
	 5.	 <!DOCTYPE html>
		  <HTML>
		  <HEAD> <TITLE> Students of Class 7 </TITLE>
		  <STYLE>
		  TABLE, TH, TD
		  {
		  border:2px; 
		  border-style:solid; 
		  border-color:green;
		  }
		  </STYLE>
		  </HEAD>
		  <BODY>
		  <TABLE>
		  <CAPTION> Table : Student </CAPTION>
		  <TR>
		  <TH> Roll No. </TH>
		  <TH> Name </TH>
		  <TH> Grade </TH>
		  <TH> Gender </TH>
		  </TR>
		  <TR>
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		  <TD> 1 </TD>
		  <TD> Aarav </TD>
		  <TD> B </TD>
		  <TD> M </TD>
		  </TR>
		  <TR>
		  <TD> 2 </TD>
		  <TD> Gauransh </TD>
		  <TD> A </TD>
		  <TD> M </TD>
		  </TR>
		  <TR>
		  <TD> 3 </TD>
		  <TD> Himakshi </TD>
		  <TD> A </TD>
		  <TD> F </TD>
		  </TR>
		  <TR>
		  <TD> 4 </TD>
		  <TD> Rakshit </TD>
		  <TD> B </TD>
		  <TD> M </TD>
			  </TR>
		  </TABLE>
		  </BODY>
		  </HTML>
F.	 a = int(input(“Enter a Number between 1 to 7: “))
	 if a ==  1 :
	     print(“Monday”)
	 elif a == 2:
	     print(“Tuesday”)
	 elif a == 3:
	     print(“Wednesday”)
	 elif a == 4:
	     print(“Thrusday”)
	 elif a == 5:
	     print(“Friday”)
	 elif a == 6:
	     print(“Saturday”)
	 elif a == 7:
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	     print(“Sunday”)
	 else :
	     print(“Wrong number entered.”)

G.	 a = int(input(“Enter a First Number: “))
	 b = int(input(“Enter a Second Number: “))
	 if a > b :
	     print(“First number is greater than second number “)
	 elif a < b:
	     print(“Second number is greater than first number “)
	 else :
	     print(“First number is same as second number “)




